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Pagrindinë prieþiûra

Áspëjimas

Ðio dokumento vertimas gali bûti naudojamas tik
kaip papildoma priemonë.

Esant neatitikimams tarp angeliðkosios versijos ir
vertimo, galioja angliðkoji versija.

Naudokite vietoje, kur temperatûra visada yra
tarp 0 ir 35 C (nuo 32 iki 95 F).

Laikykite vietoje, kurioje temperatûra visada yra
tarp -20 ir 45 C (nuo -4 iki 3 F).

Baterijø darbo laikas gali sutrumpëti prastose
temperatûrø sàlygose.

Aplankykite www.philips.com/support, norëdami
uþsakyti dalá/priedà pakeitimui.

Ausiniø naudojimas dideliu garsumu gali paþeisti
jûsø klausà.Ðis árenginys gali leisti garsus tokiame
decibelø diapazone, kad normalus þmogus gali
prarasti klausà net klausantis trumpiau nei minutæ.
Aukðtesni decibelø diapazonai naudojami tiem, kurie
jau yra susidûræ su klausos problemomis.

Garsas gali bûti apgaulingas. Po tam tikro laiko jûsø
klausa prisitaiko prie didesnio garsumo lygio. Tad
po ilgesnio klausymosi, tai, kas atrodo skamba
“normaliai“, ið tikro jau gali bûti per garsu ir
pavojinga jûsø klausai. Kad nuo to
apsisaugotumëte, nustatykite saugø garsumo lygá
prieð tai, kai jûsø klausa pripras, ir nekeiskite jo.

Saugaus garsumo nustatymas:

Nustatykite þemà garsumo lygá.

Lëtai didinkite garsà, kol pasieksite norimà vidutiná
garsumà.

Klausykitës ribotà laiko intervalà:

Ilgas klausymasis, net ir nedideliu garsumu, gali
pakenkti jûsø klausai.

Ásitikinkite, kad protingai naudojatës ðiuo árenginiu
ir darote atitinkamas pertraukas.

Atkreipkite dëmesá á toliau iðvardintus patarimus, kai
naudojatës ausinëmis:

Klausykitës ribotu garsumu ir ribotais laiko
intervalais.

Jeigu ápratote prie atitinkamo garsumo-
nebereguliuokite garso.

Nesiklausykite tokiu garsumu, jog negirdëtumëte
kas vyksta aplinkui.

Pavojingose situacijose bûkite labai dëmesingi ir
laikinai nutraukite klausymàsi.

Neklausykite grotuvo vaþiuodami motociklu,
dviraèiu ir t.t. Daugelyje vietø tai yra uþdrausta, nes
taip galite sukelti eismo ávyká.
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Norëdami iðvengti þalos arba prasto
funkcionavimo:

Nepalikite grotuvo greta pernelyg didelio
karðèio, sukelto ðildymo árangos arba
tiesioginiø saulës spinduliø.

Nenumeskite savo grotuvo ir neleiskite,
kad kiti objektai uþkristø ant jo.

Neleiskite savo grotuvui panirti á vandená.
Neleiskite ausinëms ir baterijø skyriui bûti
paveiktam vandens, nes patekæs vanduo
gali sukelti didþiulæ þalà.

Netoliese esantys veikiantys mobilieji
telefonai gali sukelti trukdþius.

Pasidarykite savo failø kopijas. Ásitikinkite,
kad esate iðsaugojæ originalius, á savo
árenginá parsisiøstus failus. Philips nëra
atsakingi uþ duomenø praradimà, jeigu
produktui yra padaroma þala arba jis yra
nenuskaitomas / áskaitomas.

Valdykite (perkelkite, trinkite ir pan.)
muzikos failus tik naudodamiesi pateikta
muzikine programine áranga, kad
iðvengtumëte problemø.

Nenaudokite jokiø valymo priemoniø,
kuriose yra alkoholio, amoniako, benzino
arba kitø dirginanèiø medþiagø, nes jos
gali paþeisti árenginá.

Naudojimo ir laikymo temperatûros

Daliø/priedø pakeitimas:

Klausymo Apsauga

Klausykitës vidutiniu garsumu:
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16. ÞODYNËLIS

B

C

D

F

L

M

R

S

Bit rate (bitø daþnis)

Compression (suspaudimas)

Decibel (decibelas) (dB)

FM (Frequency Modulation - Daþnio
moduliavimas)

Frequency Response (Daþnio “atsakas“)

FullSound (pilnas garsas)

LCD (Skystøjø Kristalø Ekranas)

Lossless compression (kompresija be praradimø)

MP3

MSC [Mass Storage Class]

MTP [ Media Transfer Protocol]

Rip / Ripping (Kopijavimas)

SuperScroll

Tai per tam tikrà laiko vienetà perduodamø bitø
kiekis. Paprastai matuojamas bitø skaièiumi per
sekundæ (ar kilobitais per sekundæ: kbps). Terminas
“bitø daþnis“ yra sinonimas terminui “duomenø
perdavimo daþnis“ (arba paprasèiausiai “duomenø
daþnis“).

Audio terminais, tai yra laikinas arba ilgalaikis audio
failø sumaþinimas skirtas tausoti vietà arba
efektyviai persiøsti failus. Laikinas failø
suspaudimas vadinamas 'non-lossy' suspaudimu ir
informacija nëra prarandama. Ilgalaikis failo dydþio
sumaþinimas (toks kaip MP3 failø) yra vadinamas
'lossy' suspaudimu, kuris neiðsaugo nereikalingos
informacijos, o pastaroji negràþinamai prarandama.

Matavimo vienetas, skirtas iðreikðti galios skirtumà
arba garso stiprumà.

Radijo transliavime: moduliavimo metodas, kuriame
perduodamos átampos daþnis kinta su moduliavimo
átampos daþniu.

Tai garsiakalbio atkuriamas daþniø spektras, nuo
þemiausio daþnio iki aukðèiausio. Áprastinis daþnio
spektras yra 20-20,000 Hz. Kiekvieno individo
girdëjimo spektras yra skirtingas. Jeigu turite pilno
spektro garso sistemà, ji skleidþia platø daþnio
spektrà. Skirtingi valdikliai skleidþia tik dalá spektro.

FullSound™ yra naujoviðka technologija, sukurta
Philips. FullSound™ patikimai atkuria garsines
smulkmenas suspaustoje muzikoje, suteikdama
muzikai galimybæ teikti maksimalø garsà be jokiø
trukdþiø.

Tikriausiai labiausiai paplitæs bûdas rodyti
informacijà nekompiuterinëje elektroninëje
technikoje.

Tai sistema, skirta duomenø bitø (tankio) maþinimui
muzikiniame signale, nepaþeidþiant originalo.

Failo formatas su garsiniø duomenø suspaudimo
sistema. “MP3“ yra Motion Picture Experts Group 1
(arba MPEG-1) Audio Layer 3sutrumpinimas.
Naudojant MP3 formatà, viename CD-R arba CD-
RW diske galima sutalpinti maþdaug 10 kartø
daugiau duomenø nei áprastame audio CD diske.

USB duomenø kaupiklio árenginio klasë (arba USB
MSC arba UMS) yra tam tikras komunikavimo
protokolø rinkinys, atminties árenginiams
suteikiantis vartojimo sàsajà. Árenginiai, suderinami
su ðiuo standartu, yra vadinami MSC (Mass Storage
Class) árenginiais.

Medijos perkëlimo protokolas (Media Transfer
Protocol) palaiko muzikiniø ir video failø perkëlimà á
neðiojamus audio ir video grotuvus.

Naudojantis atitinkama programine áranga galite
perkelti audio failus ið kompaktinio disko á
kompiuterio kietàjá diskà. Iðsaugomas duomenø
vientisumas, kadangi signalas neina per
kompiuterio garso plokðtæ ir jo nereikia konvertuoti á
analoginá formatà. Skaitmeninis-á-skaitmeniná
perkëlimas sukuria WAV failà, kuris vëliau gali bûti
konvertuojamas á MP3 failà.

SuperScroll™ yra dvigubø veiksmø narðymo
funkcija RAGA grotuve SuperScroll™ leidþia lengvai
kontroliuoti narðymo greitá, narðant per dideles
bibliotekas. Ilgesnis mygtuko paspaudimas padidina
narðymo greitá.

© 2010 Koninklijke Philips Electronics N.V.
Visos teisës saugomos.
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11. TECHNINIAI DUOMENYS

Maitinimas

Programinë áranga

Jungtys

Garsas

Audio grojimas

Saugojimo medija

Muzikos perkëlimas

Ekranas

�

�

�

* Pakraunamos baterijos gali bûti
ákraunamos ribotà kartø skaièiø ir po tam
tikro laiko jas reikës pakeisti. Baterijos
veikimo laikas ir ákrovimø skaièius
priklauso nuo nustatymø ir naudojimo.

** 1 GB = 1 milijardas baitø, saugojimo
talpa bus maþesnë. Pilnas atminties
iðnaudojimas yra neámanomas, nes tam
tikras jos “kiekis“ yra reikalingas grotuvui.
Saugojimo talpa nustatyta pagal tokius
vidurkius: 4 minuèiø daina ir 128kbps MP3
kodavimas.

*** Perkëlimo greitis priklauso operacinës
sistemos ir programinës árangos
nustatymø.

Energijos maitinimas: 220 mAh lièio polimerø vidinë
pakraunama baterija.

Grojimo laikas' (muzikos): 22 valandos

Philips Songbird: vidinës mikroprogramos
atnaujinimui ir muzikos perkëlimui

Ausinës 3.5 mm

Greitaeigis USB 2.0

Kanalø atskyrimas: 45 dB

Daþnis: 20 - 18,000 Hz

Iðvesties jëga: 2 x 2,4 mW

“Signalo á triukðmà“ santykis: > 84 dB

Palaikomi formatai:

MP3:

MP3 bitø daþniai (bit rates): 8 - 320 kbps ir VBR;

MP3 “sample“ daþniai: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

WMA:

WMA bitø daþniai (bit rates): 10 - 320 kbps CBR, 32
- 192 kbps VBR

WMA “sample“ daþniai: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

FLAC:

FLAC “sample“ daþniai: 1 - 1048 kHz

APE:

APE “sample“ daþniai: 8 - 48 kHz

WAV

Vidinës atminties talpa**:

SA2RGA02K 2GB NAND Flash

SA2RGA04K 4GB NAND Flash

SA2RGA08K 8GB NAND Flash

Songbird (sinchronizuotas)

Windows Explorer (“drag and drop“)

Spalvotas LCD, 128 x 64 pikseliai.

Windows® XP (SP2 arba naujesnis) / Vista / 7

Pentium III 800 MHz procesorius arba
greitesnis

512 MB RAM

500 MB vietos kietajame diske

Prisijungimas prie Interneto

Windows® Internet Explorer 6.0 arba naujesnis

CD-ROM diskø valdiklis

USB lizdas

�

�

�

�

�

�

�

�

Pastaba

Sistemos reikalavimai

Modifikacijos

Informacija apie autorines teises

Bûkite atsakingi! Gerbkite autorines teises.

Duomenø kaupimas

“Monkey's“ Audio dekoderis

Atlikdamas gamintojo nepatvirtintas modifikacijas
vartotojas gali netekti teisiø naudotis ðiuo árenginiu.

Visi prekiniai þenklai ir produktø pavadinimai
priklauso atitinkamoms kompanijoms ir
organizacijoms.

Kopijuodami áraðus ið Interneto ar CD diskø jûs
paþeidþiate autorines teises ir tarptautines sutartis.

Autorinëmis teisëmis apsaugotos medþiagos, tame
tarpe kompiuteriniø programø, failø, transliacijø,
garso áraðø kopijavimas yra autoriniø teisiø
paþeidimas ir yra laikomas kriminaliniu nusikaltimu.
Ðio árenginio tokiais tikslais naudoti negalima.

Windows Media ir Windows logotipai yra registruoti
prekiniai þenklai, priklausantys Microsoft
Korporacijai Amerikoje ir kitose ðalyse.

Philips gerbia intelektinæ kitø þmoniø nuosavybæ ir
mes praðome savo vartotojø elgtis taip pat.

Internete esanèiø failø turinys gali bûti sukurtas
ir/arba platinamas be autoriniø teisiø savininkø
sutikimo. Informacijos kopijavimas arba platinimas
be sutikimo gali paþeisti autoriniø teisiø ástatymus
ávairiose ðalyse, áskaitant ir jûsø.

Autoriniø teisiø ástatymø laikymasis yra jûsø
atsakomybë.

Atsisiøstø á kompiuterá video klipø áraðymas ir
perkëlimas á neðiojamàjá grotuvà yra skirtas tik
vieðiems domenams arba tinkamai licencijuotam
talpinimui. Jûs galite naudoti toká turiná savo
asmeniniam, nekomerciniam naudojimui ir turite
gerbti ámanomas autoriniø teisiø instrukcijas,
skelbiamas autoriniø teisiø savininko. Ðios
instrukcijos gali teigti ir tai, kad tolesniø kopijø
daryti negalima.

Video failai gali turëti kopijavimo apsaugos
technologijà, kuri sustabdo tolimesná kopijavimà.
Tokiose situacijose áraðymo funkcija neveiks ir jûs
bûsite informuoti þinute.

Philips yra pasiryþæ gerinti ðio produkto kokybæ ir
suteikti dar geresnæ vartojimo patirtá.

Kad bûtø geriau suprastas ðio árenginio naudojimosi
profilis, árenginys á atmintá áraðo ðiek tiek

informacijos / duomenø. Ðie duomenys skirti tam,
kad bûtø identifikuoti bet kokie nesklandumai ir
problemos, su kuriomis jûs kaip vartotojas galite
susidurti naudojimosi árenginiu metu. Kaupiami
duomenys apims, pavyzdþiui, grojimo trukmæ
tiunerio reþime, kiek kartø buvo susidurta su
iðsikrovusiomis baterijomis ir pan. kaupiami
duomenys neatskleis árenginiu groto turinio, taip pat
neparodys áraðytø failø ðaltinio. Árenginyje kaupiami
duomenys bus panaudoti TIK TUO ATVEJU, jei
vartotojas gràþina árenginá á Philips paslaugø centrà
ir TIK TAM, kad bûtø supaprastinta nesklandumø
prieþasties aptikimo ir jø prevencijos procedûra.
Sukaupta informacija turi bûti pateikta vartotojui
jam to papraðius.

1. “Monkey's“ Audio SDK ir ðaltinio kodas gali
bûti laisvai naudojami norint prie bet kurio
produkto (nemokamo ar mokamo) pridëti APE
formato grojimo, kodavimo ar “tagging“ priedà.
Kodo naudojimas firminiais tikslais,
neatitinkanèiais oficialaus APE formato,
reikalauja oficialaus raðtiðko autoriaus
sutikimo.

2. “Monkey's“ Audio ðaltinis gali bûti átrauktas á
GPL ar atvirojo kodo programinæ árangà, nors
“Monkey's“ Audio pats savaime nëra
priklausomas nuo iðoriniø licencijavimo
reikalavimø.

3. Kodo pakeitimai ir patobulinimai turi bûti
perduoti atgal “Monkey's“ Audio projektui be
jokiø apribojimø ir kompensacijø.

4. Programinëje árangoje, naudojanèioje kodà, turi
bûti aiðkiai pripaþinti naudoti kodai, idëjos ar
“bibliotekos“.

5. Nors programinë áranga buvo nuodugniai
patikrinta, autorius jokiu bûdu neatsakingas uþ
þalà, atsiradusià dël techniniø defektø ar
neteisingo naudojimo.
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Bûkite atsakingi

Gerbkite autorines teises



FLAC dekoderis

XPAT XML Parser

Autorinës teisës (C) 2000,
2000,2001,2002,2003,2004,2005,
2006,2007,2008,2009 Josh Coalson

Pakartotinis platinimas ir naudojimas, su arba be
pakeitimø, yra leidþiamas tik tuo atveju, jeigu
tenkinamos ðios sàlygos:

Pakartotiname ðaltinio kodo platinime turi iðlikti
aukðèiau nurodytas praneðimas apie autorines
teises, ðis sàlygø sàraðas ir toliau esantis
iðsiþadëjimas.

Pakartotiname platinime “binary“ formoje turi
iðlikti aukðèiau nurodytas praneðimas apie
autorines teises, ðis sàlygø sàraðas ir toliau
esantis iðsiþadëjimas, esantys dokumentacijoje
ir/ arba kitoje platinimo metu pateikiamoje
medþiagoje.

Norint reklamuoti ar kitaip patvirtinti produktus
sukurtus pagal ðià programinæ árangà, be
iðankstinio raðtiðko sutikimo negalima naudoti
nei organizacijos pavadinimo Xiph.org
Foundation, nei jos autoriø vardø.

ÐI PROGRAMINË ÁRANGA YRA PATEIKTA
AUTORINIØ TEISIØ SAVININKØ IR KÛRËJØ. ÐIAI
ÁRANGAI NËRA SUTEIKIAMOS JOKIOS
GARANTIJOS. AUTORINIØ TEISIØ SAVININKAI IR
KÛRËJAI JOKIAIS ATVEJAIS NËRA ATSAKINGI UÞ
TIESIOGINÆ, NETIESIOGINÆ, ATSITIKTINÆ,
SPECIALIÀ, TIPINÆ AR PASEKMINÆ ÞALÀ
(ÁSKAITANT, BET NEAPSIRIBOJANT PAKAITINIØ
PREKIØ AR PASLAUGØ ÁSIGIJIMÀ; NAUDOJAMOS
INFORMACIJOS AR PELNO PRARADIMÀ; AR
VERSLO SUTRIKDYMÀ), KAD IR KAIP JI BÛTØ
SUKELTA IR REMIANTIS BET KOKIA
ATSAKOMYBËS TEORIJA, NUMATYTA SUTARTYJE,
GRIEÞTA ATSAKOMYBËS FORMA AR CIVILINIØ
TEISIØ PAÞEIDIMU (ÁSKAITANT NEATSARGUMÀ
AR KITU ATVEJU), KYLANTÁ BET KOKIU BÛDU
NAUDOJANT ÐIÀ PROGRAMINÆ ÁRANGÀ, NET
JEIGU ÁSPËJAMA APIE GALIMYBÆ ATSIRASTI
TOKIAI ÞALAI.

Autorinës teisës (C) 1998, 1999, 2000 Thai Open
Source Center Ltd.

Visiems asmenims ásigijusiems ðios programinës
árangos kopijà ir susijusius dokumentacijos failus
(toliau “Programinë áranga“) nemokamai
suteikiamas leidimas platinti ðià Programinæ árangà
be apribojimø, áskaitant teisæ naudotis, kopijuoti,
modifikuoti, sujungti, skelbti, platinti, sub-
licenzijuoti ir/arba pardavinëti ðios Programinës

árangos kopijas, jeigu yra laikomasi ðiø sàlygø:

Visose Programinës árangos kopijose turi bûti
aukðèiau nurodytas praneðimas apie autorines
teises ir ðis praneðimas apie leidimà.

ÐI PROGRAMINË ÁRANGA YRA PATEIKIAMA BE
JOKIØ GARANTIJØ, MOMENTINIØ AR
NUMANOMØ, ÁSKAITANT, BET NEAPSIRIBOJANT
TINKAMUMO PREKYBAI GARANTIJAS,
TINKAMUMÀ KONKREÈIAM TIKSLUI IR
NEPAÞEIDÞIAMUMÀ. AUTORIAI ARBA AUTORINIØ
TEISIØ SAVININKAI JOKIAIS ATVEJAIS NËRA
ATSAKINGI UÞ BET KOKIAS PRETENZIJAS, ÞALAS
AR KITAS PRIEVOLES, ATSIRADUSIAS DËL
SUTARTIES, CIVILINËS TEISËS PAÞEIDIMØ ARBA,
KITU ATVEJU, SÀLYGOTAS PROGRAMINËS
ÁRANGOS AR JOS DALIES NAUDOJIMO.

Jûsø produktas yra sukurtas ir pagamintas ið
aukðtos kokybës medþiagø ir komponentø, kurie
gali bûti perdirbami arba naudojami dar kartà.

Jeigu prie savo produkto matote nubraukto ðiukðliø
konteinerio simbolá, tai reiðkia, kad produktas
pagamintas pagal Europos Direktyvà 2002/96/EC.

Niekada neiðmeskite savo produkto kartu su kitomis
namø apyvokos ðiukðlëmis. Praðome pasidomëti
vietinëmis elektriniø ir elektroniniø prietaisø
iðmetimo taisyklëmis. Jeigu teisingai atsikratysite
senu produktu, tai sumaþins neigiamà átakà gamtai
ir þmoniø sveikatai.

�

�

�

Seno produkto iðmetimas

6

1. SVARBIOS PASTABOS APIE SAUGUMÀ
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10. NUSTATYMAI

Nustatymai Nustatymø meniu Sub-nustatymø meniu

* Ekvalaizeris automatiðkai iðsijungs, kuomet bus aktyvuota FullSound funkcija.
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10. NUSTATYMAI

Ðtai kaip jûs galite keisti RAGA grotuvo nustatymus:

Pagrindiniame meniu pasirinkite , kad áeitumëte
á nustatymø reþimà.

meniu, narðykite kaip nurodyta:

Spauskite , norëdami pasirinkti
nustatymà.

Spauskite , norëdami patvirtinti
pasirinkimà ir pereiti á kità lygmená (kai galima).

Spauskite , norëdami gráþti á buvusá
lygmená.

Spauskite ir laikykite nuspaudæ ,
norëdami iðeiti ið meniu.

meniu yra galimi tokie nustatymai:

1.

2. �

�

�

Nustatymai Nustatymø meniu Sub-nustatymø meniu

Áspëjimas

�

�

Integruotos baterijos iðëmimas paþeidþia
garantijà ir gali sugadinti produktà.

Ðios iðëmimo ir iðmetimo instrukcijos yra
skirtos tam, kad bûtø imtasi tinkamø
þingsniø produkto vartojimo pabaigoje.

Pastaba Europos Sàjungai

Jûsø produkte yra integruota pakraunama baterija,
apraðyta Europos Direktyvoje 2006/66/EC, kuri
negali bûti iðmetama su áprastomis namø apyvokos
ðiukðlëmis.

Kad apsaugotumëte savo produkto funkcionalumà ir
saugumà, nugabenkite savo produktà á oficialià
surinkimo vietà ar ástaigà, kur profesionalas galës
iðimti arba pakeisti jûsø baterijà kaip parodyta:

Praðome susipaþinti su vietinëmis baterijø
surinkimo (iðmetimo) taisyklëmis. Teisingas baterijø
iðmetimas padës iðvengti potencialiai neigiamø
pasekmiø gamtai ir þmoniø sveikatai.

Ðis produktas atitinka Europos Sàjungos radijo
trukdþiø reikalavimus.

7

1. SVARBIOS PASTABOS APIE SAUGUMÀ
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RAGA grotuvas leis jums:

groti MP3 ir neapsaugotus WMA failus

klausytis FM bangø radijo imtuvo

daryti áraðus

Patikrinkite, ar gavote ðiuos daiktus:

�

�

�

Kà rasite dëþutëje

Pastaba

� Iliustracijos yra tik reprezentacinë
priemonë. Philips pasilieka teisæ keisti
spalvà/dizainà be iðankstinio perspëjimo.

2. JÛSØ NAUJASIS RAGA GROTUVAS

Grotuvà

Ausines

Greitos pradþios gidà

21

9. ÁRAÐYMAI

Áraðø ákëlimas á kompiuterá

Iðtrinkite áraðus

Naudokitës RAGA grotuvu, norëdami
perkelti duomenø failus

Pastaba

Pastaba

Patarimas

Naudokitës programa, norëdami
sinchronizuoti savo medija failus.

Prieðingu atveju, failus galite perkelti ir per
Windows Explorer.

Prijunkite RAGA grotuvà prie kompiuterio.

Naudodamiesi Windows Explorer programa,
atidarykite RAGA.

Pasirinkite katalogà arba

Kopijuokite ir ákelkite áraðus á bet kurià savo
kompiuterio vietà.

Norëdami iðtrinti nuotraukas naudojantis Windows
Explorer programa:

Prijunkite RAGA grotuvà prie kompiuterio.

Naudodamiesi Windows Explorer programa,
suraskite katalogà

3. Iðtrinkite áraðus lygiai taip pat, kaip tai
darytumëte savo kompiuteryje.

Èia apraðyta, kaip naudoti RAGA grotuvà, norint juo
perkelti arba jame iðsaugoti duomenø failus:

Prijunkite RAGA grotuvà prie kompiuterio (þr.
skyriø “ “, norëdami
instrukcijø).

Kompiuteryje per Windows Explorer programà
kopijuokite duomenø failus ir ákelkite juos á
RAGA grotuvà.

Philips Songbird

1.

2.

3. Recordings > Voice
FM radio*.

4.

1.

2.
Recordings > Voice arba

FM radio*.

1.
Prijungimas ir pakrovimas

2.
�

�

�

* FM radijo áraðymo galimybë yra tik kai
kuriuose modeliuose. Norëdami suþinoti,
kokias funkcijas turi jûsø grotuvas,
þiûrëkite RAGA grotuvo ekrano meniu.

* FM radijo áraðymo galimybë yra tik kai
kuriuose modeliuose. Norëdami suþinoti,
kokias funkcijas turi jûsø grotuvas,
þiûrëkite RAGA grotuvo ekrano meniu.

Naudokitës kompiuteriu norëdami perkelti
duomenø failus atgal á kompiuterá arba
norëdami iðtrinti perkeltus failus ið RAGA
grotuvo.
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9. ÁRAÐYMAI

Áraðykite ið FM radijo (Galioja tik su
tam tikromis versijomis!)

Áraðykite audio/balsus

Áraðø klausymas

Patarimas

Patarimas

Pastaba

1.

2. [Start FM radio
recording

3.

4.

Perþiûra,

1. [Start
voice recording]

2.

3.

1.
[Recordings Library] > [FM Radio].

2.

3.

1.
[Recordings Library] > [Voice].

2.

3.

Pagrindiniame meniu pasirinkite , kad
ájungtumëte radijo reþimà.

Nueikite á meniu ir pasirinkite
] (pradëti FM radijo áraðymà).

Spauskite , norëdami perjungti tarp
pauzës ir áraðymo.

Spauskite , norëdami sustabdyti.

Spauskite , norëdami iðsaugoti áraðà, arba
, norëdami atðaukti.

Áraðai yra iðsaugomi grotuve. (Failø
pavadinimø formatas: FMRECXXX.WAV,
kur XXX nurodo áraðo numerá, kuris yra
parenkamas automatiðkai).

Naudodamiesi ðia funkcija jûs galite áraðyti
audio/balsus su integruotu mikrofonu (þiûrëkite
skyriø norëdami suþinoti, kur yra
integruoto mikrofono vieta):

Pagrindiniame meniu pasirinkite >
(pradëti balso áraðymà).

Spauskite , norëdami perjungti tarp
pauzës ir áraðymo.

Spauskite , norëdami sustabdyti áraðymà.

Spauskite , norëdami iðsaugoti áraðà, arba
, norëdami atðaukti.

Áraðai yra iðsaugomi grotuve. (Failø
pavadinimø formatas: VOICEXXX.MP3, kur
XXX nurodo áraðo numerá, kuris yra
parenkamas automatiðkai).

Klausykitës FM radijo* áraðø:

Pagrindiniame meniu pasirinkite >

Pasirinkite áraðà.

Spauskite , norëdami groti savo áraðà.

Pagrindiniame meniu pasirinkite >

Pasirinkite áraðà.

Spauskite , norëdami groti savo áraðà.

�

�

�

�

�

�

�

�

�

�

�

Savo áraðus galite surasti per

Savo áraðus galite surasti per

* FM radijo áraðymo galimybë yra tik kai
kuriuose modeliuose. Norëdami suþinoti,
kokias funkcijas turi jûsø grotuvas,
þiûrëkite RAGA grotuvo ekrano meniu.

[Recordings
Library] > [FM Radio].

[Recordings
Library] > [Voice].

Klausykitës audio/balso áraðø:

9

3. PRADÞIA

Valdymo ir sujungimø perþiûra

Garsumo apribojimas

Áspëjimas

1

2

3

4

5

6

7

8

9

10

1. [Settings] >
[Sound settings] > [Volume Limit].

2.

3.

1. [Settings] > [Sound Settings] >
[Volume Limit].

2.

3.

ausiniø lizdas

MIC mikrofonas

ekranas

spauskite: atgal vienu lygmeniu.

spauskite ir palaikykite nuspaudæ:
sugráðite atgal á pagrindiná meniu.

grojimo reþime, spauskite:
padidinsite / sumaþinsite
garsumà.

grojimo reþime, spauskite ir
palaikykite nuspaudæ: padidinsite
/ sumaþinsite garsumà dideliu
greièiu.

spauskite: groti / pauzë /
patvirtinti

spauskite: “perðokti“ prie
tolimesnio / prieð tai esanèio.

spauskite ir palaikykite nuspaudæ:
greitai “perðokti“ prie tolimesnio /
prieð tai esanèio.

grojimo lange, spauskite ir
palaikykite nuspaudæ, norëdami
“praskenuoti“ grojamà dainà.

pastumkite ir palaikykite: RAGA
grotuvo ájungimui / iðjungimui.

pastumkite: visø mygtukø
uþrakinimui / atrakinimui.

RESET spauskite: RAGA grotuvo
perkrovimas

iðstumkite: iðtiesite USB jungties
kiðtukà.

Jûs galite nustatyti garso iðvesties lygio limità savo
RAGA grotuvui.

Pagrindiniame meniu pasirinkite

Spauskite , norëdami reguliuoti
garsumo lygá.

Spauskite , norëdami patvirtinti.
Kai jûs nustatote garso limità, RAGA
grotuvas nebegalës padidinti nustatyto
garso, net jeigu jûs spausite
mygtukà.

Norëdami vël ágalinti maksimalø garsà:

Pasirinkite

Nustatykite garso limità iki maksimalaus.

Spauskite , norëdami patvirtinti.

�

�

�

�

�

�

� Klausymasis dideliu garsumu ilgesná laikà
gali bûti pavojingas klausytojui.
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Prijungimas ir pakrovimas

Pastaba

RAGA grotuvas turi integruotà baterijà, kuri gali bûti
pakrauta per kompiuterio USB jungtá (USB laidas
pateiktas komplekte).

Jei nieko nepasirinksite, RAGA grotuvas
automatiðkai pasirinks [Charge & transfer]
nustatymà.

�

�

�

RAGA grotuvà prijungus prie kompiuterio,
jûsø trumpai papraðys pasirinkti:

(ákrovimas ir failø
perkëlimas) arba
(ákrovimas ir grojimas).

[Charge & transfer]
[Charge & play]

RAGA grotuvo prijungimas prie kompiuterio

Philips Songbird instaliavimas pirmàjá kartà

Pastaba

Pastaba

1.

2.

3.

1. Install Philips Songbird

2.

1. My Computer
Compute

2. Philips
GoGear

3. Install Philips Songbird

4.

Prijunkite pateikto USB laido kiðtukà prie laisvo
USB lizdo jûsø kompiuteryje.

Prijunkite maþàjá USB laido kiðtukà prie maþojo
USB lizdo jûsø RAGA grotuve.

Ájunkite kompiuterá.
RAGA grotuvas kraunasi.

Prijungus RAGA grotuvà prie kompiuterio pirmàjá
kartà, pasirodys praneðimas:

Pasirinkite
(instaliuokite Philips Songbird).

Norëdami baigti instaliavimà, sekite ekrane
pasirodysianèiomis instrukcijomis.

Jei automatiðkai nepasirodys praneðimø langas:

Pasirinkite (Windows XP /
Windows 2000) / r (Windows Vista /
Windows 7).

Paspauskite deðinájá pelës mygtukà virð
RAGA ikonos.

Pasirinkite
(Setup.exe).

Norëdami baigti instaliavimà, sekite ekrane
pasirodysianèiomis instrukcijomis.

�

�

�

Instaliavimo metu jûsø bus papraðyta
sutikti su licencijø sàlygomis.

Instaliavimo metu jûsø bus papraðyta
sutikti su licencijø sàlygomis.

3. PRADÞIA

Pagrindinio meniu perþiûra

Meniu

Music (muzika)

Veiksmas

skaitmeniniø garso
takeliø grojimui

klausytis FM radijo

sukurkite ir klausykitës
áraðø

kataloge esanèiø failø
perþiûra

pasirinkite norimus
RAGA grotuvo
nustatymus

parodyti dabartinio
grojimo ekranà

FM radio (radijas)

Recording
(áraðymas)

Folder view
(katalogo perþiûra)

Settings
(nustatymai)

Now playing (dabar
grojama)

Reþimas

19

Klausykitës FM radijo

Rankinis radijo stoèiø nustatymas

Automatinis radijo stoèiø
nustatymas

Nustatytos radijo stoties grojimas

Patarimas

Pastaba

1.

1.

2.

[Auto tune].

[Yes]

1.

2.

3.

Pagrindiniame meniu pasirinkite , kad
patektumëte á radijo reþimà.

Ausiniø laidas veiks kaip FM antena.

Kol esate reþime, galite rasti radijo stotis
rankiniu bûdu:

Norëdami surasti kità stiprø signalà, spauskite
ir laikykite nuspaudæ .

Norëdami tiksliai nustatyti radijo daþná, trumpai
paspauskite .

RAGA automatinio nustatymo funkcija padës jums
rasti radijo stotis ir iðsaugoti jas atmintyje kaip tam
tikrus kanalus.

1. Kol esate reþime su prijungtomis
ausinëmis, pasirinkite

Jei reikës, pasirinkite (taip), kad
patvirtintumëte.
Radijas automatiðkai nustato radijo stotis
ir iðsaugo daþnius kaip tam tikrus kanalus.
Ið viso yra 20 galimø kanalø.

Norëdami sustabdyti automatinæ paieðkà,
spauskite .
Norëdami gráþti á pagrindiná meniu,
spauskite ir laikykite nuspaudæ
mygtukà 2 sekundes.

Kol esate reþime, pasirinkite stoties
numerá.

Spauskite arba , norëdami perjungti
kità stotá.

Norëdami ieðkoti kito stipresnio signalo,
spauskite ir laikykite nuspaudæ arba
mygtukà 2 sekundes.

oNorëdami gráþti á pagrindiná meniu,
spauskite ir laikykite nuspaudæ
mygtukà 2 sekundes.

�

�

�

�

�

�

�

�

Radijas iðsijungs, kai ájungsite kità reþimà
arba kai iðjungsite ARIAZ grotuvà.

Norëdami groti radijo stotis, jûs pirma
turite jas iðsaugoti atmintyje kaip tam
tikrus kanalus.

8 RADIJAS (GALIOJA TIK SU TAM TIKROMIS VERSIJOMIS!)
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Klausykitës muzikos

“Judëkite“ po muzikiná failà

Suraskite savo muzikà

Pastaba

Pastaba

Iðtrinkite vienà ar daugiau muzikiniø failø

1.

2.

3.

1.

[Playlist-on-the-go]

Philips Songbird

1.

2.

3.

Pagrindiniame meniu pasirinkite , kad
patektumëte á muzikos reþimà.

Narðykite per papildomus sub-meniu, norëdami
pasirinkti muzikiná takelá.

Spauskite , norëdami pradëti groti arba
laikinai sustabdyti grojimà.

Spauskite , norëdami gráþti vienu lygiu
atgal.

Spauskite ir palaikykite nuspaudæ ,
norëdami gráþti á pagrindiná meniu.

Klausydamiesi muzikos spauskite ,
norëdami greitai prasukti takelá á prieká / atgal.

Pagrindiniame meniu pasirinkite , norëdami
ájungti muzikos reþimà.

RAGA jums siûlo tokius meniu nustatymus:

Takeliai iðdëstyti alfabeto tvarka

Atlikëjai iðdëstyti alfabeto tvarka

Albumai iðdëstyti alfabeto tvarka

Takeliai iðdëstyti albumø tvarka

Albumai iðdëstyti pagal skaièius ir alfabetà

Takeliai iðdëstyti albumø tvarka

Takeliai iðdëstyti grojaraðèio tvarka

Knygos iðdëstytos pagal skaièius ir alfabetà

Naudokitës programa, norëdami
sinchronizuoti savo medija failus.

Prieðingu atveju, muzikà galite iðtrinti ir per
Windows Explorer.

Prijunkite RAGA grotuvà prie kompiuterio.

Naudodamiesi Windows Explorer programa,
suraskite muzikiná katalogà RAGA grotuve.

Iðtrinkite muzikà lygiai taip pat, kaip tai
darytumëte savo kompiuteryje.

�

�

�

�

�

�

�

�

�

�

�

�

[All songs]

[Artist]

[Albums]

[Playlists]

[Audiobooks]*

�

�

�

Audio knygas galite ásigyti internetinëse
parduotuvëse, tokiose kaip audible.com.

RAGA grotuvas audio knygas valdo taip pat
kaip ir muzikinius failus.

Taip pat jûs galite pasirinkti pagrindiniame
meniu ir surasti savo muzikinius

failus per katalogus.

7 MUZIKA

11

Philips Songbird instaliavimas dar kartà (po
pirmos instaliacijos)

Baterijos lygio parodymai

Pastaba

Patarimas

Á RAGA ádiegta programinë áranga

Á RAGA áraðyti failai

Svarbu!

�

�

�

Ákraunamos baterijos turi limituotà
ákrovimø skaièiø. Baterijos ilgaamþiðkumas
ir galimø ákrovimø skaièius priklauso nuo
naudojimo ir nustatymø.

Ákrovimo animacija sustoja ir yra
parodoma ikonëlë, kuomet ákrovimo
procesas yra baigtas.

Jûs galite taupyti baterijos energijà ir ilgiau
klausytis RAGA grotuvo eidami á >

(ekrano nustatymai) >
(ekrano iðjungimo

laikmatis) ir ásitikinkite, kad nustatytas
trumpiausias laikas.

[Display settings]
[Screen off timer]

Philips Songbird programinë áranga yra gamykliðkai
áraðyta á RAGA grotuvà.

Siekiant atlaisvinti daugiau atminties jûsø
duomenims, ið RAGA grotuvo automatiðkai
iðtrinamas instaliacinis failas pirminës instaliacijos
metu.

Norëdami instaliuoti programinæ árangà bet kuriuo
kitu metu po pirminës instaliacijos, sekite ðiais
þingsniais:

Prijunkite RAGA grotuvà prie kompiuterio.

Ásitikinkite, kad kompiuteris yra prijungtas prie
Interneto, ir tada atidarykite Windows Explorer
programà.

Bûdami Windows Explorer lange spauskite
deðinájá pelës mygtukà virð RAGA ir pasirinkite
nustatymà instaliavimui.

Kompiuteris parsisiøs instaliaciná failà ið
Interneto.

Norëdami baigti instaliavimà, sekite ekrane
pasirodysianèiomis instrukcijomis

Ekrane rodoma apytikslë baterijos bûsena, kaip
pavaizduota:

Mirksintis baterijos ekranëlis rodo tai, kad
baterija yra iðsikrovusi. Grotuvas iðsaugo
visus nustatymus ir iðsijungia per 60
sekundþiø.

Á RAGA grotuvà gamykliðkai áraðyta ði programinë
áranga:

(padës jums atnaujinti RAGA
grotuvo vidinæ mikroprogramà ir perkelti
failus).

Á RAGA grotuvà gamykliðkai áraðyti ðie failai:

Naudojimosi Instrukcijos

Daþniausiai Uþduodami Klausimai

1.

2.

3.

Philips Songbird

4.

Philips Songbird

�

�

�

�

�

3. PRADÞIA



RAGA grotuvà valdo vidinë programa vadinama
mikroprograma. Gamintojai nuolatos iðleidþia
atnaujintas mikroprogramø versijas.

Programinë áranga, kuri vadinasi
gali naudoti jûsø kompiuterá, kad automatiðkai
nustatytø jûsø RAGA bûklæ ir praneðtø, jeigu
Internete atsiras mikroprogramø patobulinimø.

Ádiekite á savo kompiuterá (þr.
skyriø ) ir
sekite instrukcijomis, kad atnaujintumëte (þr. skyriø

).

Ásitikinkite, kad jûsø kompiuteris yra prijungtas
prie Interneto.

Prijunkite RAGA grotuvà prie kompiuterio (þr.
skyriø “, norëdami
instrukcijø).

Savo kompiuteryje spauskite
norëdami paleisti

Philips Songbird programà.

Pasirinkite
Philips Songbird patikrins, ar nëra
atnaujinimø ir ádiegs naujà vidinæ
mikroprogramà ið interneto, jeigu bus
ámanoma.

Sekite ekrane pasirodysianèiomis
instrukcijomis, norëdami atnaujinti RAGA
grotuvo vidinæ mikroprogramà.

Palaukite, kol atnaujinimas bus baigtas, tada
atjunkite RAGA grotuvà nuo kompiuterio.

Po mikroprogramos atnaujinimo RAGA
grotuvas persikraus ir vël bus paruoðtas
naudojimui.

Philips Songbird,

Philips Songbird
Programinës árangos instaliavimas

Vidinës mikroprogramos patikrinimas ir
atnaujinimas rankiniu bûdu

1.

2.
“Prijungimas ir pakrovimas

3. Start > Programs
> Philips > Philips Songbird,

4. Tools > Updates.

5.

6.

�

�

Pastaba

Vidinës mikroprogramos
patikrinimas ir atnaujinimas
rankiniu bûdu

� Jûsø muzikiniai failai nëra paveikiami
mikroprogramos atnaujinimo.

1.

1.

1.

2.

Norëdami pasirinkti tarp ájungimo ir iðjungimo
reþimø, paslinkite ir palaikykite mygtukà apie
2 sekundes.

RAGA grotuvas turi automatinio iðsijungimo
funkcijà, taupanèià baterijos galià.

Po 10 minuèiø “idle“ reþime (t.y. kai nëra grojama
muzika ir nepaspaudþiamas joks mygtukas) RAGA
grotuvas iðsijungs.

Paslinkite ir palaikykite mygtukà apie 2
sekundes, norëdami vël ájungti RAGA grotuvà.

RAGA grotuvas turi uþrakto mygtukà, kuris padës
iðvengti atsitiktinio valdymo.

Norëdami uþrakinti mygtukus grojimo metu,
nuslinkite mygtukà á pozicijà.

Visi mygtukai (iðskyrus garsumo
reguliavimo) bus uþrakinti, o ekrane bus
rodoma uþrakto ikona.

Norëdami vël atrakinti mygtukus, nuslinkite
mygtukà á centrinæ pozicijà.

�

�

�

Automatinis iðsijungimas

Mygtukø uþrakinimas
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“Pataisykite“ RAGA (atkurkite
gamyklinius nustatymus)

Áspëjimas

Philips Songbird

1. Philips
Songbird Programinës
árangos instaliavimas

2. Philips Songbird
Tools
Repair My RAGA

3.

turi “pataisymo“ funkcijà, kurios
pagalba galite gràþinti RAGA grotuvui gamyklinius
nustatymus.

Prieð tai darydami pasidarykite svarbiø failø,
iðsaugotø RAGA grotuve, kopijas.

Savo kompiuteryje instaliuokite
programà (þr. skyriø

) ir paleiskite programà.

programos meniu juostoje
(virðuje) spauskite ir pasirodysianèioje
lentelëje pasirinkite
(“pataisyti“ mano RAGA).

Sekite ekrane pasirodysianèiomis
instrukcijomis, norëdami uþbaigti ðià
procedûrà.

� Vykdydami èia apraðytà procedûrà
iðtrinsite visus RAGA grotuve iðsaugotus
failus ir atstatysite gamyklinius
nustatymus.

6. PHILIPS SONGBIRD
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Grojaraðèio sukûrimas

Takeliø pridëjimas prie grojaraðèio

Takeliø paðalinimas ið grojaraðèio

Pakeiskite savo Songbird
“bibliotekos“ iðvaizdà

Suformatuokite RAGA (iðtrinkite visà
muzikà ir visus duomenis)

Áspëjimas

1.

2.

File >
New Playlist.

New
Playlist

3.

1.

2.

3.

Add to
Playlist > The_name_of_your_playlist

1.

2.

3.

1.

2. View >
Feathers > Get More Feathers....

Philips Songbird

1. Philips
Songbird

2. Philips Songbird

3.
Tools.

4. Format device

5.

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite ið ðiø nustatymø, norëdami sukurti
naujà grojaraðtá:

Songbird árankiø juostoje pasirinkite

Spustelkite deðinájá pelës mygtukà virð
kairës ðoninës juostos ir pasirinkite

(naujas grojaraðtis).

Spauskite + simbolá, esantá kairëje
esanèios Paslaugø Srities apaèioje.
Paslaugø Srityje pasirodys naujas
grojaraðtis.

Áveskite naujojo grojaraðèio pavadinimà.

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite vienà ar daugiau takeliø.

Pasirinkite ið ðiø nustatymø, norëdami pridëti
pasirinktus takelius prie grojaraðèio:

Failø “tempimo ir paleidimo“ (“drag and
drop“) bûdu pasirinktus takelius
nutempkite á Paslaugø Sritá.

Spustelkite deðinájá pelës mygtukà virð
savo pasirinkimo ir pasirinkite

(pridëti prie grojaraðèio).
Visi pasirinkti takeliai bus pridëti prie
grojaraðèio.

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite grojaraðtá.

Paspauskite deðinájá pelës mygtukà virð takelio,
kurá norite paðalinti, ir tada spauskite Remove
(paðalinti).

Pasirinktas takelis bus paðalintas ið
grojaraðèio.

Norëdami galite pakeisti savo Songbird
“bibliotekos“ dizaino ir spalvø schemà. Mes tai
vadiname “plunksnø pakeitimu“. Naujos
“plunksnos“ instaliuojamos ir valdomos kaip
programos priedai.

Naujø “plunksnø“ suradimas

Ájunkite Songbird programà savo kompiuteryje.

Songbird árankiø juostoje pasirinkite

Programa ieðkos naujø “plunksnø“
(feathers).
Sekite ekrane pasirodysianèiomis
instrukcijomis, norëdami instaliuoti naujas
“plunksnas“.

turi Formatavimo funkcijà, kurios
pagalba galite suformatuoti RAGA grotuvà ir iðtrinti
visus failus ið jo vidinës atminties.

Savo kompiuteryje instaliuokite
programà (þr. skyriø Programinës

árangos instaliavimas) ir paleiskite programà.

programos Grotuvo srityje
spauskite RAGA.

“Bibliotekos“ srityje spauskite lentelæ
pavadinimu

Árankiø (Tools) srityje spauskite
(formatuoti árenginá).

Sekite ekrane pasirodysianèiomis
instrukcijomis, norëdami uþbaigti ðià
procedûrà.

�

�

�

�

�

�

�

�

�

�

� Vykdydami èia apraðytà procedûrà
iðtrinsite visus RAGA grotuve iðsaugotus
failus.

6. PHILIPS SONGBIRD

Á RAGA grotuvà gamykliðkai áraðyta Philips
Songbird programinë áranga.

Philips Songbird programinë áranga padës jums:

ásigyti naujos medijos (muzikos ir video)

susikurti medijos “bibliotekà“

valdyti savo medijos “bibliotekà“

groti muzikà ir rodyti video failus

sinchronizuoti jûsø muzikà su RAGA grotuvu

Kuomet Philips Songbird programa paleidþiama
pirmàjá kartà, norëdami “importuoti“ failus á
Songbird medija “bibliotekà“, pasirinkite ið ðiø
nustatymø:

Importuokite jau egzistuojanèià iTunes
“bibliotekà“.

Ieðkokite medija failø tam tikruose kataloguose.
(Galite nustatyti, kad tam tikras katalogas bûtø
“stebimas“, tokiu bûdu failai, kurie yra
pridedami ar iðtrinami ið ðio katalogo, bus
automatiðkai pridedami ar iðtrinami ir ið
Songbird medija “bibliotekos“).

Norëdami sukurti Songbird medija “bibliotekà“,
naudokitës vienu ar daugiau ið ðiø nustatymø:

Gamykliðkai nustatyta, kad Philips Songbird
programinë áranga instaliuoja ðiuos priedus, kuriø
reikia norint nukopijuoti CD dainas:

CD Rip Support

Gracenote Metadata Lookup Provider

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite

Pasirinkite lentelæ ir ten pasirinkite
norimus CD kopijavimo nustatymus.

Spauskite , kad patvirtintumëte.

Þemiau apraðyti þingsniai parodo, kaip galite
importuoti medija (muzikinius ir video) failus,
esanèius kitose jûsø kompiuterio ar kompiuterinio
tinklo vietose:

Ájunkite Songbird programà savo kompiuteryje.

Songbird árankiø juostoje pasirinkite , tada
pasirinkite

Pasirinkite norimus medija (muzikinius ir
video) failus ir spauskite , kad
patvirtintumëte.

Pridëtieji medija failai bus parodyti medija
“bibliotekos“ sàraðe.

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite

Songbird árankiø juostoje pasirinkite
lentelæ, tada pasirinkite

Patikrinkite “bibliotekos“ vietà ir nustatymus.

Pasirinkite
Programa importuos iTunes “bibliotekà“ á
Songbird.

�

�

�

�

�

�

�

�

�

1.

2. Tools > Options.....

3. CD Rip

4. OK

1.

2. File
Import Media.....

3.
OK

1.

2. Tools > Options.....

3. Media
importer iTunes
Import/ Export.

4.

5. Import Library.

�

�

Medija “bibliotekos“ sukûrimas

Nukopijuokite CD dainas (“Rip“ funkcija)

Pasirinkite CD kopijavimo nustatymus

Medija failø importavimas ið katalogø

Medija failø importavimas ið iTunes programos

Patarimas

� Jei pasirinkote visà katalogà, kuriame yra
muzikiniø ar video failø, programa
nuskenuos katalogà ir prie medija
“bibliotekos“ pridës visus kataloge
esanèius muzikinius ir video failus (nebus
pridëti tik besidubliuojantys failai).
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Medija failø eksportavimas á iTunes programà

Turinio gavimas ið ðaltiniø Internete

Áraðø importavimas ið RAGA grotuvo

Leiskite Songbird valdyti jûsø medija failus

Patarimas

Medija “bibliotekos“ apþvalga

Sutvarkykite ir valdykite savo
Songbird “bibliotekà“

1.

2. Tools > Options.....

3.
iTunes Import/

Export.

4.

5. Export Library.

1.

2. File
Import Media.....

3.
OK

1.

2.

3.

4.

1.

2. Tools > Options....

3. Manage
files

4. Allow Songbird to
manage my files

5.

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite

Songbird árankiø juostoje pasirinkite Media
importer lentelæ, tada pasirinkite

Patikrinkite “bibliotekos“ vietà ir nustatymus.

Pasirinkite
Programa eksportuos Songbird á iTunes
“bibliotekà“.

Failus galite ásigyti ir ið tokiø ðaltiniø internete, kaip:

7-digital

Perþiûrëkite savo RAGA grotuvo techninius
duomenis, norëdami suþinoti, kokios paslaugos yra
jums pasiekiamos.

Ájunkite Songbird programà savo kompiuteryje.

Songbird árankiø juostoje pasirinkite , tada
pasirinkite

Pasirinkite norimus RAGA grotuve esanèius
áraðus ir spauskite , kad patvirtintumëte.

Pasirinkti áraðai bus parodyti medija
“bibliotekos“ sàraðe.

Songbird medija “biblioteka“ turi tokià struktûrà:

Grotuvo Sritis (ðioje srityje rodomas RAGA).

“Bibliotekos“ Sritis (ðioje srityje matomas
“bibliotekos“ turinys).

Paslaugø Sritis (ðioje srityje matoma
papildoma informacija apie turiná, tokia kaip
grojaraðèiai).

Informacijos Sritis (ðioje srityje matoma
informacija apie pasirinktus nustatymus).

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite

Songbird árankiø juostoje pasirinkite
lentelæ.

Paþymëkite nustatymà
(leisti Songbird valdyti mano

failus).

Pasirinkite nustatymus, numatanèius, kaip bus
valdomi jûsø medija failai.

�

�

�

� Jei pasirinkote visà katalogà, kuriame yra
áraðø, programa nuskenuos katalogà ir prie
medija “bibliotekos“ pridës visus kataloge
esanèius áraðus (nebus pridëti tik
besidubliuojantys áraðai).
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Medija failø paðalinimas ið Songbird medija
“bibliotekos“

Leisti Songbird “stebëti“ katalogà

Patarimas

Medija failø iðtrynimas

Gauti albumo virðelá

Grojaraðèiai

1.

Remove

2. Remove

1.

2.

3.

1.

2. Tools > Options.....

3. Media
importer Watch
Folders.

4.

1.

Tools
> Get Album Artwork.

Bûdami Songbird “bibliotekoje“ paspauskite
deðinájá pelës mygtukà virð medija failo ir
pasirinkite (paðalinti).

Pasirodysianèiame spauskite
(paðalinti), kad patvirtintumëte, jog norite
paðalinti failà.

Pasirinktas failas bus paðalintas ið
“bibliotekos“ ir ið visø grojaraðèiø.
(Gamykliðkai nustatyta, kad failas yra
“paðalinamas“, o ne “iðtrinamas“. Pats
medija failas vis dar yra savo originalioje
vietoje kompiuteryje ar kompiuteriniame
tinkle).

Èia apraðoma, kaip iðtrinti medija failus naudojantis
Windows Explorer.

RAGA grotuvui esant prijungtam prie
kompiuterio, atidarykite Windows Explorer
programà.

Raskite medija failø katalogà RAGA grotuve.

Iðtrinkite failus lygiai taip pat, kaip tai
darytumëte norëdami iðtrinti failus bet kurioje
kitoje kompiuterio vietoje.

Jûs galite leisti, kad Songbird automatiðkai:

stebëtø katalogo turiná ir

pridëtø arba paðalintø medija failus ið jûsø
“bibliotekos“ taip, kad ji atitiktø katalogo turiná.

Ájunkite Songbird programà savo kompiuteryje.

Pasirinkite

Songbird árankiø juostoje pasirinkite
lentelæ, tada pasirinkite

Pasirinkite katalogà, kuriame bus “stebimi“ visi
pokyèiai.

Pasirinktas katalogas bus stebimas ir
Songbird programa derins katalogo turiná
su “bibliotekos“ turiniu.

Pasirinkite ið ðiø nustatymø, norëdami savo
albumams atsisiøsti virðeliø apipavidalinimus.

Ájunkite Songbird programà savo kompiuteryje.

Songbird árankiø juostoje pasirinkite

Jei nepasirinktas konkretus takelis,
Songbird bandys gauti virðelius visiems
“bibliotekoje“ esantiems takeliams.

Spustelkite deðinájá pelës mygtukà virð
pasirinktø takeliø.
Songbird gaus virðelius visiems
pasirinktiems takeliams.

Gamykliðkai nustatyta, kad Philips Songbird
programinë áranga instaliuoja ðiuos priedus, kuriø
reikia norint nukopijuoti CD dainas:

CD Rip Support

Gracenote Metadata Lookup Provider

�

�

�

�

�

�

�

�

�

�

�

�

Norëdami kompiuteryje (PC) pasirinkti
kelis failus, spauskite ir laikykite nuspaudæ

mygtukà.

Norëdami pasirinkti kelis ið eilës einanèius
failus, spauskite ir laikykite nuspaudæ
mygtukà.

Ctrl

Shift
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